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1. DMP Editor - General InformaƟon 
1.1 What is the DMP Editor? 
The DMP Editor is an applicaƟon for viewing and ediƟng SNOTEL and SCAN data. The key features of the DMP Editor are 
the following: 

 View or edit SNOTEL data 
 Select large amounts of data 
 Graph the data and edit the data directly on the graph by dragging points 
 Export data to your PC as delimited files (.csv or .txt) 
 Filter the data to only a subset of the original data you requested 
 Provide an easy way to edit multiple values at the same time (mass edit capability) 
 Provide tools to identify data quality problems quickly and easily 
 Print data and charts 
 Export charts as an image 

1.2 Overview of the EdiƟng Process 
The DMP ediƟng process involves two steps:  

1. Select the data to view/edit (using the Data Editor Setup screen).  
2. View and/or edit the data that has been retrieved using the tools available on the window that contains the data.  

The data is presented in a spreadsheet-like grid. The data for only a single staƟon and group can be viewed at a given 
Ɵme, but you can easily switch to any of the staƟons and groups selected.  

1.3 RequesƟng Data for EdiƟng (Data Editor Setup screen) 
The first step in using the DMP Editor is requesƟng the data to view or edit. There are four different criteria that must be 
specified.  

1. A list of sites (station and aliases) 
2. The sensors and/or groups 
3. A range of dates for which to retrieve data 
4. The number of values to retrieve for each day (the frequency) 

Each of these criteria have lists to choose from. You can select an item from a list or you can select the Custom buƩon 
below the list to change it into a text box where you can enter the selecƟon criteria. To return to the lists, just press the 
buƩon that begins with Std.  
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For each secƟon that has a Custom buƩon, there is a Help buƩon that appears aŌer hiƫng the Custom buƩon. Pressing 
the Help buƩon displays a screen with informaƟon that can be specified for that criteria. 

Specific informaƟon on each of the search criteria is detailed in the table below. 

Criteria Feature Details 
Site List ConfiguraƟon  A list of aliases that represent a group of sites to retrieve. This list is dependent on the 

lists that have been defined for the logged-in user. The list will be empty if you don’t 
have any site aliases.  

 To view the sites within an alias, click the Contents buƩon 
 Click Custom to specify a comma-separated list of staƟon IDs, paƩerns to match, or 

.state or .dco codes to retrieve  
Sensor/Group SelecƟon  A list of sensors to display within the editor 

 You can configure this with the DMP ConfiguraƟon Editor. Once the desired sensors are 
configured, click Download Config within the tool to generate a new dmp_seƫngs.json 
file to place in your DMP folder.  

o NOTE: You must download the DMP seƫngs file OR you must generate it to 
your local DMP folder to configure a custom list of sensors. If you skip this step, 
you will see a default list instead.  

 Click Reload to refresh the list to reflect changes from your DMP seƫngs file during your 
session 

 AlternaƟvely, click Custom to specify a comma-separated list of sensor labels, paƩerns 
to match, or groups to retrieve 

Quick Date SelecƟon  A list of date ranges for the data you wish to retrieve 
 Click Custom to specify a Beginning and Ending Date for a custom date range in YYYY-

MM-DD format 
Frequency  Indicates the frequency of sensor data to retrieve 
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The screenshot below shows the Data Editor Setup Screen with each of the default lists. In this example, there are no site 
aliases defined, so the first list is blank. 

 

AŌer you have entered all the selecƟon criteria, press the Retrieve Data buƩon to retrieve the data and display the DMP 
Editor screen. 
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2. DMP Editor 
When you click the Retrieve buƩon on the DMP Data Editor Setup Screen, the DMP Editor window will display the first 
site selected. The DMP Editor screen can only show the data for a single staƟon at a Ɵme, but you can navigate to the 
other sites that have been selected using the arrows on the toolbar or the drop-down list of sites. 

Here is an example of what you will see in the DMP Editor window. 
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The main screen of the DMP Editor consists of three parts: 

1. The table of data values 
2. The DMP toolbar 
3. The menu 

2.1 The Table of Data Values 
You can view and edit data in the table of data values. EdiƟng data in this table is very similar to how you would edit data 
in a MicrosoŌ Excel spreadsheet. Not all users have permission to edit data for all sites. If you do not have permission to 
edit data for a parƟcular site, the text in the white columns will be italicized and will turn red. An annotated image of the 
table of data values is shown below and describes the layout of the table and other useful informaƟon. 

 

2.1.1 Navigating Between Cells 

There are two ways to navigate between cells in the table of data values. 
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1. Use the arrow keys to go leŌ, right, up, or down. If you go leŌ or right, the table will navigate to the next current 
data column and will skip over the original data columns. 

2. Press Enter on the keyboard to go down to the next cell.  
 

If you are at the end of a column and you press Enter or use the down arrow key, the table will navigate to the top of the 
next "current" data column. If you are at the end of the last column, the next cell that the table will navigate to will be 
the top of the first "current" data column. 

2.1.2 Editing Data 

Cells are editable if you have permission to edit data for that station. You can tell if the cells are editable if the text in the 
"current" columns is black and not italicized. If the text in the "current" columns is red and italicized, the data is not 
editable. 

The flags for the data values cannot be edited directly. Here are the rules that determine how the flags are set based on 
how the data is edited. 

 If a value is edited to a blank, the flag will be set to "S" (except if the original value and flag are blank in which 
case the flag will be set to blank also) 

 If an existing value is edited to the same value as the original value, the flag will become valid or "V" if the 
original flag is "S". If the original flag was something other than "S", the flag will become the same as the original 
flag. The following are a few different ways for changing an "S" flag to a "V" flag: 

1. You can double-click on the cell for the value and then press [Enter]. 
2. You can do a mass edit of one or more values by doing a "=+0.0" mass edit operation 
3. You can navigate to a cell (using arrow keys or by single-clicking on it) and type the letter 'v'. This is a 

shortcut for changing the value to "V" if the flag is "S" and then navigating to the next cell. If the flag is 
not "S", the value will not be edited, but the DMP Editor will still navigate to the next cell.  

 For all other edits, the flag will become "E". 

2.1.3 Selecting Data 

You must select data in DMP Editor to execute the various operaƟons that can be done on the data such as Mass Edits 
and graphing. These operaƟons will be covered in other secƟons. In this secƟon, we'll cover how to select cells. SelecƟng 
cells in DMP works like other applicaƟons you are probably familiar with such as Excel. The table below describes the 
various ways to select data in DMP. 

Selection Operation How to do it 
Select a single cell Click in the cell 
Select an entire column Click on the column header of the column to select 
Select multiple columns Click on the first column header and then CTRL+click the other columns 
Select a range of cells in a 
column 

Click on the first cell to select, then drag up or down to select the other cells 
in the range - OR - click in the first cell to select, then SHIFT+click in the last 
cell to select. Alternatively, click SHIFT+PageUp/Down to select a page of 
cells at a time. 
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Selection Operation How to do it 
Add cells to current 
selection 

Hold down CTRL and click on the cells to add to the selection. 

Select cells from multiple 
sites 

Select the cells on the first site, then click the Keep Currently Selected Cells 
buƩon  in the toolbar and navigate to the next site you want to select cells 
for. Next, select the desired cells and press the same buƩon again. ConƟnue 

the same steps for all the sites you want to select data from.   
Clear all selected cells Click the Clear Selected and Keep Selected Cells button. 

  

2.1.4 Copy & Paste Operations 

You can copy the data in the DMP table of data values to the clipboard by selecƟng cells and then pressing CTRL+C. To 
paste cells, select the cells to paste into (or just select the cell where you want to start pasƟng data into) and then press 
CTRL+V.  

Copy and paste support works best when selecƟng a conƟguous set of cells for a single column to copy from or paste 
into. Copy and paste operaƟons work within DMP and between MicrosoŌ Excel and DMP. 

2.2 The DMP Toolbar 
The DMP Toolbar contains buƩons that allow you to navigate between staƟons, save or discard edits, print, select cells, 
and graph data. The image below shows the toolbar with a descripƟon of each buƩon. 
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2.3 DMP OperaƟons 

2.3.1 Navigating between stations 

NavigaƟng between staƟons can be done in two ways.  

1. Use one of the four navigaƟon buƩons on the toolbar 
2. Use the drop-down list of sites in the toolbar. The drop-down list allows you to jump to a specific site 

immediately. 

It is important to note that when the DMP Editor window is first displayed, only the first site that has been selected is 
guaranteed to be loaded. All the other sites are loaded in the background. The Ɵme to load the remaining sites will 
depend on the amount of data that has been selected for retrieval.  

The navigaƟon buƩons and the drop-down list will not allow navigaƟng to a site that has not been loaded yet. To 
determine if a site is loaded or not, hover the mouse over the name of the site in the drop-down list of sites. If the site 
name is grayed out, it has not been loaded yet and you will not be able to select it.  

2.3.2 Saving and Discarding Edits 

You can save all edits that have been made since the last save by clicking on the Save all edits buƩon on the DMP toolbar 
or by using the keyboard shortcut key CTRL+S. You can undo all edits that have been made since the last save by pressing 
the Discard all edits since last save buƩon (the trash can icon). 

2.3.3 Mass Editing Data 

The DMP Editor has a mass edit feature. This means you can edit mulƟple values at the same Ɵme. There are two ways 
to use the mass ediƟng feature – the standard Mass Edit and a custom Mass Edit. 

2.3.3.1 Mass Edit 
The Mass Edit feature can set values to some fixed number or can perform simple calculaƟons on the values such as 
adding, subtracƟng, mulƟplying, or dividing the values by some constant. 
 
To use the Mass Edit feature, first select all the cells that you want to perform a Mass Edit on. Then click the Mass Edit 
buƩon  on the DMP toolbar. 

  

 When you click the Mass Edit buƩon, you will see the following dialog: 
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To set all the cells that were selected to a parƟcular value, enter the value in the box and press OK. To apply an operaƟon 
to the selected values, enter one of these accepted formulas: 

Mass Edit Formula Description 
=n Sets the values to the number n (this is the same as just 

entering a number). 
=+n Adds the number n to each value. 
=-n Subtracts the number n from each value. 
=*n Multiplies each value by the number n. 
=/n Divides each value by the number n. 

 
NOTE: In the table above, n represents a floaƟng-point number. 

2.3.3.2 Custom Mass Edit 
Another way to mass edit values is to use the Custom Mass Edit funcƟonality of the DMP Editor. Custom Mass Edit allows 
you to edit values for one or more sites. You can also edit where the values are for certain labels and change values that 
meet some condiƟon for the value and/or the flag.  

You will see the Custom Mass Edit screen when you select the Custom Mass Edit buƩon  on the toolbar.   
 
DMP ignores any cells that are selected when the buƩon is clicked and instead uses the custom criteria defined within 
the modal to determine the data to update. If you’d like to make sure no cells are selected, simply click the Clear 
Selected and Keep Selected Cells buƩon on the toolbar before you click the Custom Mass Edit buƩon.  

The "Custom Mass Edit" screen is shown on the following page: 
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The Custom Mass Edit window displays a list of all that staƟons that are viewable in the current session. You can select 
one or more of the sites by clicking on the site in the list. To select all sites, click the Select All buƩon. Click the Clear 
buƩon to de-select all sites. 

The Sensor(s) field allows you to specify a comma separated list of sensor labels you’d like to apply to the mass edit. Any 
data value that is currently filtered in the DMP Editor and whose label matches any of the sensor label paƩerns entered 
will be edited using the Mass Edit formula or value given when you click Apply Edits.  

Each sensor label paƩern can contain the '*' or '?' wildcard characters and will match against the sensor label that is 
displayed in the column header for the data value. The '*' wildcard character matches 0 or more characters and the '?' 
wildcard character matches any single character.  

In addiƟon, the syntax for specifying a sensor with a given height/depth value is supported by specifying a colon ':' aŌer 
the sensor label followed by the height/depth value.  

For example, if you wanted to match all sensors at a depth of 2 inches, you would use the sensor label paƩern '*:-2'. If 
you wanted to match all sensors that begin with 'SMO' and have a depth of 2 inches, you would use the paƩern 'SMO*:-
2'. If you wanted to select sensors that begin with 'SMO' for all depths, you would use the paƩern 'SMO*'. 

The Value CondiƟon and Flag CondiƟons fields allows you to apply a "condiƟonal" mass edit based on the value and/or 
the flag of the values. For example, if you only want to apply the Mass Edit to values that are less than 0 and have a "V" 
flag, select Less Than in the Value CondiƟon, enter "0" in the textbox to the right of the dropdown list, and check the box 
for only the "V" flag in the Flag CondiƟons secƟon. 

The Custom Mass Edit feature works well when used in combinaƟon with the date range and or frequency filters. These 
filters hide values that do not match the filter from the table of data values as well as from operaƟons such as the 
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Custom Mass Edit. You can filter the data that needs to be "mass" edited, then do a custom mass edit. This will ensure 
that only the data that is visible in the table of data values and matches the sensor label paƩern will be edited.  

2.3.4 Filtering Data by Date Range 

One of the menus of the DMP Editor is the Date Range filter menu. This menu has opƟons for filtering the data in the 
table of data values for all staƟons by date range. You can filter data to a custom date range by either using a pre-defined 
date range or by creaƟng as a custom date range. 

A sample date range menu is shown below with descripƟons of each of the opƟon next to each menu item. 

 

Note: The middle secƟon of the menu (the items beginning with "Current - ") will be different depending on the data 
that you select on the Data Editor Setup Screen. There may be more "Current -" menu items, fewer, or none. If you 
selected a Custom date on the Data Editor Setup Screen, there will be no "Current -" menu items, and in its place will be 
a single menu item that has the custom date range that was selected. 

If the Custom opƟon is chosen, the dialog that will be displayed is shown below. The "Custom" opƟon allows seƫng the 
starƟng and ending Ɵmes also. 

 

AŌer the beginning and ending dates are set in the dialog, select the Apply Filter buƩon to filter the data. To undo the 
date range filtering, select the All Days item in the Date Range menu. 
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2.3.5 Filtering Data by Frequency 

The Frequency filter menu has opƟons for filtering the data in the table of data values for all staƟons by frequency or 
Ɵme. There are some pre-defined frequencies that can be selected as well as a custom frequency opƟon that allows you 
to specify a custom frequency or list of Ɵmes to filter to.  

 

The seƫng for "Suppress bogus 00:01" readings can be toggled by clicking on that menu item. If you select that opƟon, 
the rows with 00:01 Ɵmestamps will be hidden. 

If you select the "Custom" frequency opƟon, a dialog box will prompt you to enter a custom frequency. This dialog is 
shown below: 

 

The table below lists possible frequencies that can be entered into the custom frequency dialog. 

Frequency Description 
.1 First reading of the day. 
.01 First reading of the day plus the next reading of the day if the first reading 

of the day is a 00:01 reading. Also, any values for 09/30 23:59 are also 
displayed. 

.n A dot followed by a number n will filter the values to show the 
first n readings per day where n is an integer between 1 and 23. 

A time in the format 
HH:mm 

Entering a time will show only the records whose time equals the time 
entered. 

A comma separated 
list of times in the 
format HH:mm 

This feature allows you to filter the records to show only selected times. 
For example, if you wanted to see only 00:00 and 23:59 records, you would 
use a frequency of "00:00,23:59". 

2.3.6 Exporting Data 

The DMP Editor allows you to export data to comma (.csv) or tab (.txt) delimited files. The data that is exported is the 
same data that is visible. This means that for any of the data that has been filtered using the date or frequency filters, 
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only the data that matches those filters will be exported. You can export data for a single staƟon or for all staƟons that 
are in the current session.  

To export data for a single staƟon, navigate to that staƟon in the DMP Editor using the navigaƟon buƩons on the DMP 
toolbar or by selecƟng the site from the drop-down list of sites. Then go to the File menu and select Export. You will be 
prompted with an Export File As dialog to save the file. The dialog will have a default name for the file that will be the 
site number followed by the site name. At the boƩom of the Export File As dialog, there will be a drop down where you 
can select the file type to export as. You can select from Tab delimited file (.txt) or Comma separated file (.csv). Click Save 
to export the data to the file. 

To export data for all sites that are loaded into the current DMP Editor session, go to the File menu, and select the Export 
All opƟon. AŌer selecƟng the opƟon, you'll be prompted with the following dialog that asks whether you would like to 
export the data to .csv or .txt files: 

 

AŌer you click Export Format, you'll be prompted to select a directory where the files will be exported to. AŌer you 
select a directory, click Open to export the data. There will be one file created for each site that is loaded into the current 
DMP Editor session. The files will be named with the site ID followed by the site name. 

2.3.7 Quality Control Tools 

The DMP Editor has tools for doing some basic quality control checks. These tools are available on the 'Quality Control' 
screen. Access this screen by clicking on the 'Quality Control' menu item of the 'Data' menu. 

 

You can run several quality control checks. These checks include:  

 Flag values that are null (blank values) 
 Flag values that are less than a specified value 
 Flag values that are greater than a specified value 
 Flag decreases in values (a value is flagged if it is less than the previous value) 
 Flag suspect values (values with a flag of "S") 
 Flag if an Oct 1, 00:00 value is not 0.0 (this is primarily for ensuring that precipitation values for the beginning of 

the water year are 0.0). 

The quality control checks can be applied to one or more of the staƟons that have been loaded into DMP and the user 
can specify the sensors to apply the checks to.  
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The "Sensors" field allows you to specify a comma separated list of sensor labels to apply the quality control checks to. 
Each sensor label paƩern can contain the '*' or '?' wildcard characters and will match against the sensor label that is 
displayed in the column header for the data value. The '*' wildcard character matches 0 or more characters and the '?' 
wildcard character matches any single character.  

In addiƟon, the syntax for specifying a sensor with a given height/depth value is supported by specifying a colon ‘:’ aŌer 
the sensor label followed by the height/depth value.  

For example, if you wanted to match all sensors at a depth of 2 inches, you would use the sensor label paƩern '*:-2'. If 
you wanted to match all sensors that begin with 'SMO' and have a depth of 2 inches, you would use the paƩern 'SMO*:-
2'. If you wanted to select sensors that begin with 'SMO' for all depths, you would use the paƩern 'SMO*'. 

The 'Quality Control' screen is shown below. 

 

To perform quality control checks, do the following: 

1. Click on the sites to check 
2. Enter the sensors to check 
3. Select the quality control checks to perform and enter lower/upper bounds 
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4. Click Search button to display the results 
5. Once the results are displayed, you can click on a row in the results table to select that record in the DMP Editor 
6. Use the "Print Results" button to print the entire table of results 

The Quality Control feature operates on the data that is currently visible in the DMP Editor. To quality control all data, 
make sure that there aren't any date or frequency filters applied and that all the data are visible in the DMP Editor. 

2.3.8 Changing the Appearance of the Data Table 

The Data menu also provides a way to customize the appearance of the Data Table. These options are intended to allow 
the user to focus their attention on those data scenarios requiring review to stand out better. The options may also be 
used to remove unnecessary columns to fit more sensors within the view. 

A description of each option is provided below: 

 

These options will retain their settings within the current DMP session when changed via the menu. When DMP is 
closed, the settings will revert to their default. The default settings for these options may be changed via the DMP 
ConfiguraƟon Editor. 

2.3.9 Moving, Deleting, or Merging Bogus (00:01) Records 

DMP generates 00:01 records when no midnight data is stored for a given day. Once you enter data into the 00:01 record 
and save it via DMP, the 00:01 record is stored into the database. This 00:01 record can be managed within DMP. DMP 
allows three operaƟons for the 00:01 record. The record can be moved, deleted, or merged.  

Moving a Bogus Record to Midnight 
If a 00:01 record exists and no midnight record exists for the same day, you can right-click anywhere on the row of the 
00:01 record and a popup menu will display as shown on the following page: 
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You can click the "Move 00:01 record to 00:00 record" to change the Ɵme of the 00:01 record to 00:00. You must sƟll 
click Save to permanently save the changes to the database. 

DeleƟng or Merging a Bogus Record 
If a bogus record exists (a 00:01 record) and a 00:00 record also exists, the 00:01 record can be deleted or the contents of 
the 00:01 record can be merged into the 00:00 record. Right-click on a 00:01 record to display a popup menu that shows 
the acƟons you can perform. Merging means that all the values from the 00:01 record (except those that are empty) will 
be copied from the 00:01 reading into the 00:00 reading and the 00:01 records will be deleted. The diagram below shows 
the popup menu and the acƟons that are available when a 00:01 and a 00:00 reading exists for a given day. Just like a 
regular edit, the changes are not made in the database unƟl you click Save in the DMP Editor toolbar. 
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3. Graphing Data 
The DMP Editor has a graphing capability that can be used for viewing and/or ediƟng data. You can graph any data that 
can be selected in the DMP Editor. A single graph can contain data from one or more staƟons. The amount of data that 
can be graphed is only limited by the amount of memory available. 

3.1 SelecƟng Data to Graph 
SelecƟng data for graphing is no different than selected data for ediƟng. See the SelecƟng Data secƟon for the DMP 
Editor for informaƟon on selecƟng data.  

Note: When selecƟng data for graphing if data is selected from more than one column (regardless if the column is from 
the same site or another site) the data must have at least one Ɵmestamp that is the same between all the columns 
selected. The graphing capabiliƟes only graph data that have the same Ɵmestamps when mulƟple columns are selected. 

3.2 Displaying the Graph 
To create a graph, first select the data to be graphed, then click on the graph buƩon. The graph buƩon is on the DMP 
Toolbar and is displayed below. 

 

There are two opƟons for the graph: 

1. By default, the graph will be the editable graph, which allows ediƟng by dragging points on the graph if the 
underlying data is editable.  

2. There is also a non-editable graph that will not allow ediƟng of data, even if the underlying data is editable. The 
purpose of the non-editable graph is to prevent accidental edits of data if you just want to view the data and 
have no intenƟon of ediƟng data on the graph. 

Clicking the graph buƩon will display a new window with the graph containing the data you selected. More than one 
graph can be displayed at the same Ɵme. To display another graph, select another set of data and press the graph 
buƩon. 

Note: Do not edit the same data on mulƟple graphs as the data between the graphs will not be synchronized. 
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Here is an example of the graph table:  
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3.3 Graph OperaƟons 
The graph toolbar contains many opƟons for determining how the graph will look. It also contains a buƩon for prinƟng 
the graph. All the opƟons are also available from the menus. This secƟon covers several graph operaƟons that cannot be 
done from the toolbar.  

3.3.1 Editing 

The graph can contain editable and non-editable data. The legend for the graph will indicate which of the data series are 
editable, and which are not. You can edit series by dragging the points on the graph up or down. As you drag the point, 
you will see the value of the point at the current posiƟon. When you edit a value on a graph, the change is immediately 
reflected in the DMP Editor's table of values.  
 
(Note: If a value is edited in the DMP Editor table of values while a graph is displayed, the graph will not update to reflect 
the edit, but changes in the graph will be updated in the table of values). 

3.3.2 Zooming and Scrolling 

If you have a lot of data on the graph, you may want to zoom into a parƟcular region or scroll the graph up, down, or to 
either side. To zoom into a region, hold down the ShiŌ key and drag a box around the area you want to zoom into, then 
release the mouse. When you release the mouse buƩon, the graph will zoom into the selected region. You can repeat 
the process to achieve the desired zoom level. To scroll the graph, hold down the CTRL key and drag the graph in the 
direcƟon that you want to scroll it. To reset the graph, press the leƩer R key. 

3.3.3 Resizing the Graph 

You can resize the graph by dragging any of the corners of the graph window. You can resize the graph to fit the enƟre 
screen by hiƫng the maximize buƩon on the top-right of the Ɵtle bar. 

3.3.4 Changing the Title of the Graph 

If you are prinƟng or saving a graph, you may want to change the Ɵtle of the graph. You can do this by selecƟng "Set 
Chart Title..." from the "Edit" menu. You will then be prompted for a new Ɵtle. 

3.3.5 Exporting a Graph as a JPEG Image 

You can export a graph to a JPEG image by selecƟng "Save As JPEG" from the File menu. The size of the image will be 
based on the size of the graph window when the "Save As JPEG" menu item is selected. 

3.3.6 Printing a Graph 

You can print a graph by clicking the buƩon on the graph toolbar that has the icon of a printer or by selecƟng the "Print" 
menu item from the File menu. You can preview the graph before it is printed. The preview screen will allow the user to 
specify margins and other page format opƟons. 
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3.3.7 Set Y-Axis Scale 

You can set the Y-Axis scale by selecƟng the Set Y-Axis Scale menu item from the OpƟons menu. AŌer you select Set Y-
Axis Scale, this window is displayed: 

 

To change the Y-Axis scale, enter the minimum and maximum Y values for the scale in the dialog and click the Apply Y-
Axis Scales buƩon. 

3.3.8 Add a Secondary Y-Axis 

If the graph is ploƫng mulƟple series of data and the units and/or magnitudes of the values for each series differ 
significantly, you may want to add a secondary Y-Axis to plot data in a meaningful way. To set a secondary Y-Axis, click on 
the "OpƟons" menu and then select the "Set Secondary Y-Axis" menu item. AŌer clicking on the menu item, the 
following dialog will pop up to allow you to choose which series to plot on the secondary Y-axis. 
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The following graph is an example where there is a secondary Y-Axis defined. The series on the secondary Y-axis grid are 
the series that have the dashed lines. 
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3.4 Graph Data Rules 

3.4.1 Graphing of 00:01 Values 

Values with Ɵmestamps of 00:01 are always ploƩed as midnight values (00:00). See the example below: 
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If both the 00:00 and the 00:01 readings exist for the same day for the same staƟon and element, then only the 00:00 
value will be displayed in the chart and the value at 00:01 will be ignored. See the example below:  

 

 


